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Welcome

This guide is intended for anyone who is setting up or starting to use a Dell Dimension
XPS Dxxx computer system. Both first-time and experienced computer users should

complete Chapter 1 to properly configure a system for operation. The remaining chap-
ters describe procedures for accessing the Internet and using software and hardware.

CAUTION: Before using this guide, connect the system according to the
steps on the Getting Started sheet. Failure to properly connect your system
may result in computer malfunctions or damage.

Safety Instructions

Safety instructions for setting up and using your system are given throughout this
guide. The Reference and Troubleshooting Guide provides detailed safety information.

Abbreviations, Acronyms, and Terms

Abbreviations, acronyms, and computer terms are identified or defined as they are
used in this guide. For a complete listing, refer to the Glossary in the Online Guide.

Notational Conventions

NOTE: A NOTE conveys important information that helps you make better use of your
computer system.

CAUTION: A CAUTION indicates either potential damage to hardware or
loss of data and tells you how to avoid the problem.

WARNING: A WARNING indicates the potential for bodily harm and tells
you how to avoid the problem.

If You Need Help

If you need help while using this guide, refer to Chapter 6, “Frequently Asked Ques-
tions.” For detailed troubleshooting procedures, refer to the Reference and
Troubleshooting Guide
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Getting
Started

The Getting Started sheet provides
step-by-step instructions for connecting
your computer system. Start with this
document.

Dell D The Setup Guide explains how to
prepare your system for operation.
It also describes how to access
the Internet and use software and
hardware.

The Reference and Troubleshooting
Guide provides maintenance informa-
tion, instructions on installing upgrades
like memory, and troubleshooting pro-
cedures for solving common problems.

e : The Online Guide replicates important

gy ol O B ' information from both the Setup Guide
and Reference and Troubleshooting Guide.
It is provided for those who prefer online
documents to printed ones.

To open the guide,
click the Start button,
point to Programs—>Dell Accessories,

and click Online Guide.é
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CHAPTER 1

Preparing Your Computer System
for Use the First Time

After you connect your computer system according to the steps on the Getting
Started sheet, you need to prepare it for use the first time you start it. Your Dell
Dimension® XPS Dxxx system has been shipped with either the Microsoft ®
Windows® 95 or Microsoft Windows NT® operating system already installed. Per-
form the steps in the setup procedure corresponding to your operating system so the
software functions properly on your Dell® system.

As part of the software setup, you need approximately two boxes of blank diskettes to
make backups of your Dell-installed software.

Setting Up Windows 95

Initial setup of Windows 95 takes about 30 minutes. The setup process is customized
according to which computer components you have.

CAUTION: Do not connect devices such as printers or install items such as
expansion cards before you complete your Windows 95 setup. These
devices should only be connected or installed afterward.

Do not interrupt the operating system’s setup process. Doing so may ren-
der your computer unusable.

If you experience problems, do not use <Ctrl><Alt><Del> to reboot your
system. Turn off and then turn on your system. When prompted, select Safe
Recovery Mode to continue the setup.

To complete the initial setup of Windows 95 on your Dell system, follow these steps:
1. Turn on your system.

NOTE: The message Press <del> to enter Setup occurs each time
the computer system boots (starts). Do not press <Del> right now.

The Software Licenses screen appears (see Figure 1-1). By pressing <y>, you are
agreeing to read the printed software license agreement for the Dell-installed
software that came with your system.
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Figure 1-1. Software Licenses Screen

2. Press <y> to continue.

The Express Service Code screen appears (see Figure 1-2). The Express Service
Code helps expedite technical support from Dell. Record the code and store it in
a safe place.
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Figure 1-2. Express Service Code Screen
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10.

11.

12.

Press <x> to continue.

When the Complete the Dell Setup screen appears, read it and press
any key to continue.

Several windows are displayed.

NOTE: As you use the Windows 95 Setup program, click Next >, press the right-
arrow key, or press <Enter> to continue to the next step.

When the Regional Settings window appears, select the regional set-
ting for your location and then click Next>.

This setting tells Windows 95 how to display numbers, dates, time, and currency.

In the Keyboard Layout window, accept the default keyboard from the
list and then click Next>.

Enter your name and company name, if applicable, and then click
Next>.

The Name field must be completed; the Company Name field is optional.

Read the license agreement, click | accept the agreement, and then
click Next>.

After you accept the license agreement, the Certificate of Authenticity window
appears. If you do not accept the agreement, you cannot access Windows 95.

Find the Certificate of Authenticity number on the front cover of the
Introducing Microsoft Windows 95 book, enter the number in the field
provided, and then click Next>.

When the Start Wizard window appears, click Finish.

The Setting Up Hardware window appears and informs you that Windows 95 is
setting up hardware and any Plug and Play devices found in your computer.

If prompted, enter the computer name, workgroup, and computer
description in the Identification tab of the Network window. Then click
Close.

The Network window only appears if you have a network card installed.

CAUTION: Do not make any changes in the Configuration or Access
Control tabs. Doing so may render your system unusable.

The Setting Up Control Panel window appears and informs you which items
Windows 95 is setting up.

In the Date/Time window (see Figure 1-3), click the appropriate date
and time properties for your location. Click Apply and then click Close.
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Figure 1-3. Windows 95 Date/Time Properties Window

13. In the Add Printer Wizard window, click Cancel.

CAUTION: To prevent possible conflicts with Windows 95, you must not
/! begin printer setup until the Windows 95 setup is complete.

14. When notified that setup is complete, click OK to restart your computer.
15. Click Cancel if prompted for your network user name and password.
You can complete network setup after the Windows 95 setup.

Windows 95 now sets up your hardware, the Control Panel, shortcuts in the Start
menu, Windows Help, MS-DOS® program settings, and the Windows Messag-
ing System. This process may take several minutes.

16. Click Yes to restart your system and enable Windows 95 to configure
your system with the information you supplied.

17. When rebooting is complete, enter your network password if prompted.
Various windows appear, depending on the options you purchased.

18. Proceed to the “Making Program Diskette Sets” procedure to create
backup diskettes for your Dell-installed software.
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Making Program Diskette Sets

It is extremely important that you create original diskette copies, or program diskette
sets, of your Dell-installed software. You will need them if you ever have to reconfig-
ure or reinstall this software. Follow these steps to create program diskettes:

1.

10.
11.

If the IntelliMouse Productivity Tips window is open on the desktop,
close the window by clicking the X in the upper-right corner.

Start the Program Diskette Maker program.

Windows 95 users: Double-click the Program Disk Maker icon in the Dell Acces-
sories folder. If the folder is not open on the desktop, click the Start button, point
to Programs—>Dell Accessories, and then click Program Disk Maker.

Windows NT users: Click the Start button, point to Programs—>Dell Accessories,
and then click Program Disk Maker.

The Program Diskette Maker main menu screen opens. A button with a diskette
icon appears next to each program or driver set listed, along with the number of
diskettes required.

Click the button of the program or driver set for which you want to
create a diskette set.

In the Diskette Options window, click the Create all diskettes in the set
radio button. Then click OK.

Label a blank diskette according to the prompt in the dialog box. Then
insert the diskette in the diskette drive and click OK.

The following message appears: Warning: Any data on this diskette
will be erased!

Click OK to start the diskette creation process.

If you are prompted to insert additional diskette(s), remove the dis-
kette currently in the diskette drive, and insert a new blank diskette.

When a dialog box appears with the message Your program dis-
kette(s) have been created! , click OK.

Repeat steps 3 through 8 to create program diskettes for each of the
remaining programs and driver sets listed.

Click Exit to quit the program, and store all diskette sets in a safe place.

If your computer has Windows 95, proceed to the “Completing Dell
Setup in Windows 95" procedure.

If your computer has Windows NT, your setup is complete. Proceed to the
end of Chapter 1.
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Completing Dell Setup in Windows 95

After you make your program diskettes, run the Dell Setup program so your Dell-
installed software, including virus protection, works properly with your operating
system. To complete this setup, follow these steps:

1. Double-click the Dell Setup icon (see Figure 1-4).

Figure 1-4. Dell Setup Icon

The Dell Setup program runs. When it finishes, a dialog box instructs you to
restart the computer.

% NOTE: After the system restarts, the Dell Setup icon no longer appears.
2. Click OK.
3. Click the Start button, and then click Shut Down.
4, Click the Restart radio button, and then click OK.
When Windows restarts, the installed virus-scanning program displays a window.

5. Click OK, and then close the program by clicking the X in the upper-
right corner.

You should run the virus-scanning program any time you add new software. All
Dell-installed software was checked before its installation on your system.

6. Your setup is complete. Proceed to the end of Chapter 1.

Setting Up Windows NT

If you are on a local area network (LAN), check with your network administrator before
setting up Windows NT for information relevant to the setup process, such as the
computer name, the administrator password, and required network protocols. Also
attach the network cable (if applicable) and any devices you want to use with your
system.

\ CAUTION: Do not interrupt the operating system’s setup process. Doing so
/! may render your computer unusable.
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Initial setup of Windows NT takes about 30 minutes. To configure Windows NT for
your system, follow these steps:

1.

Turn on your system and any attached devices.

The Software Licenses screen appears. By pressing <y>, you are agreeing to
read the printed software license agreement for the Dell-installed software that
came with your system.

Press <y> to continue.

The Express Service Code screen appears. The Express Service Code helps
expedite technical support from Dell. Record the code and store it in a safe place.

Press <x> to continue.

The setup program examines your computer’s hardware and copies to your hard-
disk drive the files needed to run Windows NT. After several minutes, the system
reboots and the Microsoft software license agreement appears.

Read the license agreement, and then click the | Agree button.
You must accept the agreement to proceed with the setup of Windows NT.
In the Windows NT Setup window, click Next> to continue.

Type your name and organization (up to 50 characters each) and click
Next>.

In the Registration window, enter your 20-digit product ID number and
click Next>.

The number is located on the Certificate of Authenticity on the front cover of the
Microsoft Windows NT Workstation manual.

In the Administrator Account window, type your administrator pass-
word (up to 14 characters) in the Password field and in the Confirm
Password field. Then click Next>.

CAUTION: The administrator password is the user account used to
manage the overall network configuration. It is case-sensitive and con-
trols maximum access to your computer. Store the password in a safe
place; if it is lost the operating system must be reinstalled.

In the Windows NT Setup window, click Next>.

If your system has a network card installed, the network card is automatically
detected and the required files are copied to your hard-disk drive. Go to step 10.

If you do not have a network card installed in your system, go to step 13.
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10. When prompted for information about network connections, click the

11.

12.

13.

14.

15.

16

17

Do Not Connect This Computer to a Network at This Time radio button.

Setup configures your files to run Windows NT, and the appropriate files are then
copied to your hard-disk drive.

NOTE: You can add or update network hardware or software after completing this
setup procedure by double-clicking the Network icon in the Control Panel and pro-
viding the necessary information.

Click Next>.

The Computer Name window appears and prompts you to enter the name of
your computer.

Type the unique name used to identify your computer on a network (up
to 15 characters) and click Next>.

If you have a modem installed, the Install New Modem window appears. Con-
tinue with step 13.

If you do not have a modem installed, click Cancel and proceed to step 18.
Click Next> to let Windows NT detect any installed modem.

Dell recommends that you let Windows NT detect your modem. However, you
can click the Don’t Detect My Modem; | Will Select From a List radio button, and
then manually select a modem.

Click Next> to continue the modem setup, or click Change... to select a
different modem.

Windows NT then installs the modem drivers and prompts you for information
about your current location.

Select the appropriate country from the drop-down list box. Provide
your area (city) code and any number required to access an outside
line. Specify whether you are using tone or pulse dialing. Then click
Next>.

If you do not provide an area (city) code, the Dialing Properties dialog box appears
and prompts you to enter a code.

When a message tells you that the modem setup was successful, click
Finish.

Verify the settings in the Modem Properties window; then click Close.
The Setup program continues configuration and file installation.

If you receive a message warning you that your system is running low on registry
quota or virtual memory, click OK. Dell adjusted the registry so that you should
not exceed the memory threshold.

A dialog box appears and states that Windows NT has been installed.
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18. Remove any diskettes and CDs from your computer’s drives.
19. Reboot your computer by clicking the Restart Computer button.

20. When prompted to select an operating system, use the up- or down-
arrow key to highlight Windows NT Workstation Version 4.00 (default
setting) or Windows NT Workstation Version 4.00 (VGA Mode). Then
press <Enter>.

If no action is taken within 30 seconds, the default setting is selected
automatically.

21. When prompted, press <Ctrl> <Alt><Del> to log on to Windows NT.

22. At the Logon Information window, type the administrator password you
entered in step 8 and click OK.

23. Proceed to the “Creating a Windows NT Emergency Repair Diskette”
procedure.

Creating a Windows NT Emergency Repair Diskette

The emergency repair diskette saves your original configuration and can be used to
restore your system to its initial setup state if files become corrupted. It should not be
used as a backup tool.

To create the emergency repair diskette, follow these steps:
1. Click the Start button and point to Programs.
Click the Dell Accessories folder.

2

3. Click the Create Repair Disk icon.

4. In the Repair Disk Utility window, click Create Repair Disk.
5

Label a diskette “Emergency Repair Disk,” insert it into the diskette
drive, and click OK.

The diskette is formatted and the configuration files are copied to it.
6. When the Repair Disk Utility window reappears, click Exit.

7. Remove the diskette from your diskette drive, and store it in a safe
place.

8. Create backup diskettes for your Dell-installed software (refer to
“Making Program Diskette Sets” found earlier in this chapter).
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Congratulations!
Your system is set up and ready to use.

What’s Next?

Chapter 2 provides information on connecting to the Internet. You must have an
online service or Internet service provider to access the Internet.

Chapter 3 orients you to the Windows desktop. It also tells you how to change your
wallpaper and screen saver, create shortcuts, and position icons.

Chapter 4 describes how to access, install, and remove software. It also covers basic
file management, such as finding, copying, deleting, and renaming files.

Chapter 5 provides basic information and tips on using your computer hardware. Also
included are general instructions for adding a printer.

Chapter 6 offers answers to commonly asked questions about your computer system.

Online Guide

For your convenience, the information provided in Chapters 3 through 6 of this Setup
Guide is available online. The Online Guide can be a handy reference tool as you work
on your desktop. It allows you to search for information in multiple ways and to quickly
link to related topics.

To open the guide, click the Start button, point to Programs—>Dell Accessories, and
click Online Guide.

Preparing Your Computer System for Use the First Time 1-11
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CHAPTER 2
Connecting to the Internet

The Internet is the largest network in the world, linking millions of educational, com-
mercial, and government sites that span the globe. The World Wide Web (or Web) is a
subset of the Internet.

You can use the Internet to find information (like the latest news and stock prices),
exchange files and electronic mail (e-mail), buy products and make travel arrange-
ments, obtain service, and so on. For example, Dell Computer Corporation has a Web
site at http://www.dell.com/ that provides information on its products, order forms
for purchasing products, and an extensive suite of online technical support services.

To access the Internet, you must do the following:

1. Set up your modem (a device that allows you to communicate with other
computers over a telephone line).

2. Set up an account with an online service or an Internet service provider
(ISP).

3. Set up your Internet browser (a program used to view Web documents).

After you complete these steps, you are ready to access the Internet.

Setting Up Your Modem

If you ordered your system with a Dell-installed modem, it was set up along with
other devices during the operating system setup. Make sure you connected the tele-
phone line(s) to it as illustrated on the Getting Started sheet that came with your
system.

If you are using Windows 95 and add a modem to your system, the new modem may
be automatically detected the next time you turn on your computer. In this case, a
New Hardware Found window appears and prompts you for information about the
modem so that Windows 95 can identify and load the appropriate drivers. You

must then restart the system for the configuration information to take effect. If
Windows 95 does not detect and set up your modem, refer to the manufacturer’s
documentation or contact the manufacturer for assistance.
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If you are using Windows NT and add a modem, it must be set up manually. Follow
the instructions in the modem manufacturer’s documentation or contact the manufac-
turer for assistance.

Setting Up an Account

After you set up your modem, the next step to accessing the Internet is to set up an
account with an online service or ISP. An online service provides software for connect-
ing to a network of services, including the Internet. An ISP is a company that allows
you to dial into its host server to connect directly to the Internet.

NOTE: Dell is not an online service or ISP Questions about the setup or use of an
Internet browser, online service, or other Internet-related software should be directed
to your online service provider or ISP

Online Services Folder

Your Dell computer has software installed for several major online services in the
Online Services folder. To access this folder, click the Start button, point to Programs,
and click Online Services.

When you click an icon in the folder, the software prompts you for the information
needed to access that provider. The following online services are available:

® America Online
® AT&T WorldNet
*  CompuServe®

¢ Microsoft Network

For information about these online services, including setup instructions and contact
numbers, click About the Online Services in the Online Services folder.

NOTE: Dell does not provide technical support for these online service providers. If
you have any questions concerning a provider's policies or offerings, contact the
online service.

Obtaining an ISP

Local ISPs are listed in your telephone directory under “Internet.” When choosing an
ISP, compare various services providers by asking the following questions:

How much idle time is allowed before being disconnected from your service?
ISPs usually set a limit of inactivity before disconnecting you from their service.
What is your fastest connect speed?

Make sure the ISP supports the speed of your modem and the X2 transmission
standard.
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How many e-mail accounts come standard with your service?

Most services provide at least one free e-mail account. You may also be able to pur-
chase additional accounts.

Does your service support ISDN?

Integrated Services Digital Network (ISDN) is a digital transmission standard that
uses fiber optics for higher data transfer speeds.

NOTE: You must have an ISDN modem and ISDN telephone service to take advantage
of ISDN transfer speeds.

Is your setup program automated or will | have to manually set up my dial-up
connection?

If setup is a manual process, find out how much support the ISP provides.

If I have problems getting your setup program installed, how can | get help?
ISPs usually provide a telephone number you can call.

Do you provide a browser and e-mail program?

Most ISPs provide a popular browser like Microsoft Internet Explorer (already installed
on your computer) or Netscape Navigator. Make sure the ISP provides setup instruc-
tions for the browser software.

Is your software compatible with my operating system?
Make sure the software is compatible with Windows 95 or Windows NT.
How many users can connect to your service at one time?

The more people that can connect at once, the less chance you have of getting a busy
signal.

Do you provide free space for my personal Web page?

Most ISPs provide about 5 megabytes (MB) free.

Setting Up Your Browser

Dell installed Internet Explorer 4.x on your computer. You can use this browser or any
other browser supported by your ISP When you contact your ISP for instructions on
setting up a browser, be prepared to provide the following information:

®* Type of computer, including the microprocessor speed
® Operating system version
® Type of modem

® Internet browser software
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Setting Up Internet Explorer 4.x

To configure the Internet Explorer 4.x browser software installed on your computer,
double-click the Internet Explorer icon on your desktop (see Figure 2-1).

Figure 2-1. Internet Explorer Icon

The Internet Connection Wizard starts and prompts you to set up the software to
work with your modem or network card. You can also set up connections for an ISP.

Using Internet Explorer 4.x

If you are unfamiliar with Internet Explorer 4.x, take advantage of the features in the
Welcome — Microsoft Internet Explorer window (see Figure 2-2). Click the Take a
Quick Tour button for a tutorial describing the differences between Windows 95 and
Internet Explorer 4.x. Click the Explore Channels button to launch a tutorial on Active
Channels, and click Register Online to register as a licensed owner of the software.
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Figure 2-2, Welcome - Microsoft Internet Explorer Window

Internet Explorer 4.x Channel Bar

The Internet Explorer Channel bar (see Figure 2-3) provides a quick way to connect to
various Internet sites, including the Dell Web site.
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Figure 2-3. Internet Explorer 4.x Channel Bar

Although the Channel bar comes with preset channel content, you can customize it to

access any Web site you choose.
To close the Channel bar, follow these steps:

1. Position your mouse near the top of the Channel bar or multimedia
window.

2. Select the down arrow from the gray bar above the Channel bar.

3. From the menu, select Close.

To open the Channel bar, follow these steps:

1. Click the Start button, point to Settings, and then click Control Panel.
Double-click the Display icon, and then click the Web tab.

Click the Internet Explorer Channel bar check box.

powow

. Click Apply, and then click OK.

Connecting to the Internet
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Web View

Internet Explorer 4.x adds Web environment features to the standard Windows inter-
face, such as the ability to single-click an icon, file, or folder to open it.

To disable this Web View, right-click on the desktop, point to Active Desktop, and then
uncheck View as Web Page (click the item if it is checked). Or click the Start button,
point to Settings, click Active Desktop, and then uncheck View as Web Page.

To reactivate Web View, right-click on the desktop, point to Active Desktop, and then
click View as Web Page. Or click the Start button, point to Settings, click Active Desk-
top, and then click View as Web Page.

To change the view of folders, click the Start button, point to Settings, and then click
Folders & Icons. Select the General tab, click the option you want (Web View, Classic,
or Custom), and click OK.

Dell Channel Features of Internet Explorer 4.x

The Dell Channel provides a full range of personalized service and support. You can
view and buy Dell products ranging from systems and peripherals to software, read
about what's new at Dell, learn about system upgrades, and receive personalized ser-
vice for your Dell system. You can subscribe free to the Dell Channel by clicking the
Get Updates Now icon at the end of the Welcome to your new Dell computer multi-
media presentation.

The address of the Dell Channel is http://www.dell.com/channel. The Dell Channel
is also accessible by clicking the Dell icon in the Internet Explorer 4.x Channel bar (see
Figure 2-3).

NOTE: You must have an Internet connection to fully utilize the Dell Channel.

Removing Internet Explorer 4.x

If you need to remove Internet Explorer from your computer, refer to “Removing
Internet Explorer 4.x From Your System” in Chapter 4.
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CHAPTER 3
Customizing the Windows Desktop

This chapter describes the main features of the Windows desktop and explains how
to customize the operating system for your use. It also tells you how to get help while
using Windows.

If you are a new Windows user, the Windows tutorial can help orient you to Windows
operations. To access the tutorial, click the Start button and then click Help. On the
Contents tab, double-click Tour: Ten minutes to using Windows.

If you’ve used previous versions of Windows and want to find out what has changed,
click the Start button and then click Help. On the Contents tab, double-click If you've
used Windows before.

Major Features of the Windows Desktop

Although your system may vary slightly depending on its hardware and software
configuration, the Windows desktop has many standard features (see Figure 3-1).
Table 3-1 describes these features.

My
cDmputer /ntel’net
icon Explorer
Channel bar
Recycle
Bin icon
Internet
Explorer
icon
program
buttons
taskbar
Start
button

el F L L e e I e e (T A
Figure 3-1. Windows Desktop
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Table 3-1. Major Features of the Windows Desktop

Feature

Function

Taskbar

Start Button

My Computer

Recycle Bin

Internet Explorer

The area at the bottom of the screen is called the taskbar.
When you open a program, a button appears on the taskbar.
The taskbar contains the Start button on the left and a clock on
the right. You may also see other icons on the taskbar, depend-
ing on your system’s software and hardware features.

The Start button provides access to the contents of your
computer. Click the Start button to display a menu containing
the system’s main program and program group icons (see Fig-
ure 3-2). Refer to Table 3-2 for descriptions of the Start menu
options.

Double-click this icon to display the contents of your computer.
Icons appear for any installed drives, as well as the Control
Panel, printers, and so on. Refer to “My Computer” in
Chapter 4 for more information.

When you delete a file from your system, it moves to the Recy-
cle Bin, where it can later be retrieved. To permanently remove
files, empty the Recycle Bin as explained in “Deleting Files™ in
Chapter 4.

Double-click this icon to launch the Internet Connection Wizard
and prepare to access the Internet.

Start
button

FErograms 4
Favorites L4

taskbar

ok
o)}
$
0
-]
=
3
H

Figure 3-2. Start Button Menu

32 Dell Dimension XPS Dxxx Systems Setup Guide



Table 3-2. Start Menu Options

Start Menu Option

Function

Programs

Favorites

Documents
Settings
Find

Help

Run...

Log Off User...
Suspend
Shut Down...

Displays a list of installed programs you can start.

Displays a list of favorite Web content and sites, including
the Dell Channel.

Displays a list of most-recently opened documents.
Displays a list of user-configurable system components.

Displays a menu to help you find files, folders, or computers
to which you are connected.

Opens the help system that provides instructions for using
Windows. Refer to “Using Windows Help” found later in
this chapter for more information.

Displays a window for starting a program or file with an
MS-DOS command.

Logs off current user so that a new user can log on.
Puts Windows into suspend mode.

Displays a window with options for shutting down,
restarting, or logging off of your computer system.

For more information on the Windows desktop, refer to the Microsoft documentation
that accompanied your system.

Working Within Program Windows

Each program and document has a title bar at the top of the window that displays the title
of the window. The title bar includes three small icons on the right side (see Figure 3-3).

minimize button

maximize button

close button

resize button

Figure 3-3. Windows Title Bar
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Click the minimize button to close the window but leave the program running (click
the program’s button on the taskbar to restore the window). Click the maximize but-
ton to size the window to the screen, and click the resize button to return the window
to its original size. Click the close button to close the document or program.

Each time you open a program, a button for that program appears on the taskbar (see
Figure 3-4). You can click the buttons to toggle between open programs.

program

ren M
Al - = N e e e P s | =1 Cavred Parad 4P

Figure 3-4. Taskbar and Program Buttons

Control Panel

The Control Panel contains many of the tools used to change how Windows looks and
works. To access the Control Panel, follow these steps:

1. Click the Start button, point to Settings, and then click Control Panel
(see Figure 3-5).

A window containing system setup icons appears.
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Figure 3-5. Control Panel Window

Typical icons include Display, Keyboard, Mouse, and Printers.

NOTE: The icons in the Control Panel vary depending on the hardware and soft-
ware configuration of your computer system. Point your mouse cursor at an icon
to pop up a short description of its settings.
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2. Double-click an icon to see the settings that you can change for that
item.

Setting Up Display Properties

The Display Properties window contains controls for customizing the way Windows
looks on your system. For example, you can change your desktop’s wallpaper (back-
ground) and screen saver. To access display settings, follow these steps:

1. Click the Start button, point to Settings, and then click Control Panel.
2. Double-click the Display icon.

The Display Properties window opens with the Background tab selected by
default (see Figure 3-6).

T |- |
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preview
E — window
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Background ta
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fI B 1 button
e ]
i Deplar || — Display
Walll list = =
allpaper lis l - pull-down
menu
[ ] e | |

Figure 3-6. Background Tab of the Display Properties Window

Changing the Wallpaper

The wallpaper (background appearance of the Windows desktop) is changed on the
Background tab of the Display Properties window. Table 3-3 describes the various
parts of this tab. After you make any changes, click OK to apply (activate) them.
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Table 3-3. Background Tab Features

Feature Function
Preview window Displays the current wallpaper or pattern.
Wallpaper list Click the name of the wallpaper you want to display, or click

(None) if you prefer not to use a wallpaper image. Click the
Browse button to use images in a directory you specify.

Pattern button Click the Pattern button to display a list of patterns for your
desktop, or click (None) if you prefer not to use a pattern.
This option is not available if the Tile option has been applied
to a wallpaper selection.

Display pull-down Click Tile to tile a wallpaper image across the entire screen,
menu or click Center to place a single copy of the image in the
center of the screen.

Changing the Screen Saver

Screen savers are programs that prevent a static image from damaging the monitor.
They start automatically after a user-defined period of inactivity. To change your sys-
tem’s screen saver, click the Screen Saver tab in the Display Properties window (see

Figure 3-7).
i Prapies @@
Bk oy T | pepwrcn | wied | esng |
Screen / i prevfeW
Saver tab window

| Settings
button
Screen Saver i v| s | e |
pull-down menu (=TT | wmfi :|.-..u.\\\
=T I
;| ST

Figure 3-7. Screen Saver Tab of the Display Properties Window

Table 3-4 describes the various parts of the Screen Saver tab. After you make any
changes, click OK to apply them.
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Table 3-4. Screen Saver Tab Features

Feature Function

Preview window Displays the current screen saver.

Screen Saver pull-  Choose a screen saver from the pull-down menu, or click

down menu (None) if you prefer not to activate a screen saver.

Settings button Click this button to change various features of the screen
saver.

Preview button Click this button to run the currently selected screen saver.

NOTE: Depending on your monitor, you may also have fields for other display controls,
such as energy-saving features. For more information, refer to the documentation that
came with your monitor.

Shoricuts

Shortcuts are icons that provide quick access to frequently used programs, files, fold-
ers, and drives. By double-clicking a shortcut, you can open its corresponding folder or
file without having to find it first. Shortcuts do not change the location of files; if you
delete a shortcut, the original file is not affected.

Creating a Shortcut on the Desktop

To create a shortcut, follow these steps:

1.

Open the My Computer window or Windows Explorer.

To open the My Computer window, double-click the My Computer icon on the
desktop.

To open Windows Explorer, right-click the Start button and then click Explore.
Find the item for which you want a shortcut.

Using your right mouse button, click the object and drag it to the
desktop.

Release the right mouse button.
A menu appears next to your cursor.
Click Create Shortcut(s) Here.

An icon appears on your desktop that you can double-click at any time to activate
the shortcut.
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Arranging and Positioning Shortcuts

The shortcuts you create on your desktop can be easily moved and arranged. To indi-
vidually move shortcuts, point your mouse cursor at the icon, click it, and drag it to the
desired location.

To arrange all of your shortcut icons at once, follow these steps:

1. Move your mouse cursor to an empty spot on the desktop, and click the
right mouse button.

2. From the pop-up menu, point to Arrange Icons.
3. Click the option for the icon arrangement you prefer.

The icons are automatically arranged.

Using Windows Help

An extensive help system is built into your Microsoft operating system. To access
Help, click the Start button and then click Help.

The Help Topics: Windows Help window appears (see Figure 3-8).

Hrlp lrgue “wirdea Hep

Combomty b |Frud |

L e e L L [ T
I

£ [k g ol arer e, el e ik Dacder

(=] | _cred |

Figure 3-8. Index Tab of Windows Help

The Contents tab lists help topics by subject, the Index tab lists topics alphabeti-
cally, and the Find tab lets you search for topics based on words you provide.

For more information on using Windows Help, refer to Microsoft Windows docu-
mentation that came with your system.
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CHAPTER 4
Using and Installing Software

This chapter provides information about using Windows 95 and Windows NT to per-
form basic tasks, such as starting programs, managing files, and properly shutting
down your computer system. It also discusses adding and removing software pack-
ages and loading device drivers.

Accessing Programs

To access your programs, follow these steps:
1. Click the Start button, and then point to Programs.

In the Programs menu, a folder icon appears next to program groups with
multiple programs.

2. Click the program you want to start.

Basic File Management

Windows 95 and Windows NT provide file management and browsing capabilities
with Windows Explorer and My Computer.

My Computer

My Computer contains various icons that represent the contents of your computer.
Icons appear for any installed drives, as well as the Control Panel and printers. To
open the My Computer window (see Figure 4-1), double-click the My Computer icon
on the desktop.
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Figure 4-1. My Computer Window

To view the contents of any drive or folder, double-click its icon. As shown in
Figure 4-1, your hard-disk drive may be partitioned into multiple logical drives. Each
logical drive appears as a separate drive letter (C:, D:, E:, and so on).

For more information on My Computer, refer to the Microsoft documentation that
came with your system.

Windows Explorer

Windows Explorer displays the contents of your computer as a hierarchical list, or tree
(see Figure 4-2). You can use this program to locate files on any drive or folder in your
computer.

To open Windows Explorer, click the Start button, point to Programs, and then click
Windows Explorer. Alternatively, you can right-click the Start button and then click
Explore.
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Figure 4-2. Windows Explorer

The left side of the window shows drives and folders, and the right side lists the files
in the drive or folder selected. A plus (+) icon to the left of a drive or folder indicates
the presence of additional folders. Click the plus icon to expand the view one level. To
collapse the view, click the minus (-) icon to the left of a drive or folder.

Finding Files
To locate a particular file or folder, follow these steps:

1. Click the Start button, point to Find, and then click Files or Folders.

The Find: All Files window opens with the Name & Location tab selected and the
cursor in the Named: field (see Figure 4-3).
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Figure 4-3. Find: All Files Window
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Type the name of the file or folder you want to find.

Specify where you want Windows to search by clicking the arrow next to
the Look in: field.

NOTE: If you leave the default setting (C:), Windows searches the entire hard-disk
drive (or drive C partition).

Click the Find Now button to begin the search.

Windows lists any files meeting your search criteria below the Find: All Files
window.

Copying Files

To place a copy of a file in a new location, follow these steps:

1.

2
3.
4
5

Use Windows Explorer or My Computer to locate the file you want to copy.
Click the file to select it.

Click the Edit menu, and then click Copy.

Open the folder where you want to copy the file.

Click the Edit menu, and then click Paste.

Moving Files

CAUTION: Do not move files that are part of an installed program. Doing
so may render the program unusable.

To move a file to a new location, follow these steps:

—
.

Use Windows Explorer or My Computer to locate the file you want to move.
Click the file to select it.

Click the Edit menu, and then click Cut.

Open the folder where you want to move the file.

Click the Edit menu, and then click Paste.

Renaming Files
To change the name of a file, follow these steps:

1.

Use Windows Explorer or My Computer to locate the file you want to
rename.

Click the file to select it.

Click the File menu, and then click Rename.
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4. Type the new filename and press <Enter>.

CAUTION: Do not change the filename extension (last three characters
after the period). Doing so may render the file unusable.

Deleting Files

CAUTION: Do not delete files that are part of an installed program. Doing
so may render the program unusable.

To delete a file, follow these steps:
1. Use Windows Explorer or My Computer to locate the file you want to delete.
2. Click the file to select it.

3. Click the File menu, and then click Delete.

Retrieving a Deleted File From the Recycle Bin

When you delete a file, it moves to the Recycle Bin. It is not removed from the sys-
tem until you empty the Recycle Bin.

CAUTION: Files deleted from a diskette or from a network drive are erased
permanently. They are not sent to the Recycle Bin.

If you delete a file in error and need to retrieve it from the Recycle Bin, follow these
steps:

1. Double-click the Recycle Bin icon located on the desktop.

The Recycle Bin window opens and lists all deleted files, their previous locations,
and the date you deleted them.

2. Click the file you want to restore.
3. Click the File menu, and then click Restore.

The file disappears from the Recycle Bin and is restored to its original location.

Emptying the Recycle Bin

Deleted files sent to the Recycle Bin still use space on the computer’s hard-disk drive.
To free up disk space, periodically empty the Recycle Bin by following these steps:

1. Double-click the Recycle Bin icon located on the desktop.

The Recycle Bin window opens and lists all deleted files, their previous locations,
and the date you deleted them.

2. Click the File menu, and then click Empty Recycle Bin.
3. When a confirmation dialog box appears, click Yes to delete the file(s).

All files disappear from the Recycle Bin and are removed from the system.
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Shutting Down Your Computer

\ CAUTION: To prevent data loss, it is important that you perform the follow-
/! ing shutdown procedure before you turn off your computer.

To shut down your computer, follow these steps:
1. Exit any applications in which you are working.
2. Click the Start button, and then click Shut Down.
The Shut Down Windows dialog box appears with the Shut down radio button

selected (see Figure 4-4).

Shut Down Windows E |

YWwhat do you want the computer to do?

" Restart
" Restart in M5-005 mode

(] 4 I Cancel Help

Figure 4-4. Shutdown Window

3. Click OK to shut down your computer.

A message states that your system is shutting down. The computer auto-
matically turns off after the shutdown process finishes.

4. Turn off your monitor and any other devices connected to power.

Installing and Configuring Additional
Software

If you are unsure whether Dell installed a particular software package you ordered,
you can quickly check by clicking the Start button, pointing to Programs, and scanning
the programs listed in the Programs menu. If the program is listed, it has already been
installed and you do not need to reinstall it from the diskettes or CDs you received
with your system. Store the diskettes and CDs in a safe place.

Before installing any new software, check the program'’s specifications to ensure that
it was designed to run on your computer’s installed hardware and software. For
example, many software packages list the microprocessor, minimum memory config-
uration, and hard-disk drive space required for proper operation. They also list the
operating system versions that are compatible with the software.
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To install or configure new software on your computer, follow the manufacturer’s
instructions. If it fails to install or run properly, contact the software manufacturer for
technical support.

NOTE: DellWare® products are supported by the item's manufacturer. To receive
product support information, call 1-800-753-7201

Removing Software

To remove a program from your computer, follow these steps.

CAUTION: Do not interrupt or stop this process once begun; otherwise, data
loss and corruption of your operating system could result.

1. Click the Start button, point to Settings, and then click Control Panel.
2. In the Control Panel, double-click Add/Remove Programs.

3. Select the program you want to delete from the programs listed, and
click the Add/Remove... button.

4. Follow the instructions and prompts to delete all installed components.

5. When finished, click OK.

Removing Internet Explorer 4.x From Your System
If you must remove Internet Explorer from your computer, follow these steps.

CAUTION: Do not interrupt or stop this process once begun; otherwise, data
loss and corruption of your operating system could result.

1. Click the Start button, point to Settings, and then click Control Panel.
2. In the Control Panel, double-click Add/Remove Programs.

3. Select Microsoft Internet Explorer 4.x from the programs listed, and
click the Add/Remove... button.

4. Click the Uninstall Internet Explorer 4.x and all its components radio
button. Then click OK.

The Microsoft Internet Explorer 4.x Setup window appears with the message
Welcome to the Microsoft Internet Explorer 4. X installation
maintenance program

5. Click OK.

The uninstall utility removes the program and reboots the system to finalize the
changes.
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Device Drivers

Drivers are software files that enable your computer to communicate with installed
and connected devices. For example, many of the program diskettes you made in
Chapter 1 contain drivers (such as audio drivers).

All of the devices installed by Dell already have drivers installed. If you add devices,
such as a printer, they may require additional drivers to work properly. Contact the
device manufacturer if the necessary drivers are not provided on a diskette or CD.

If you are using Windows 95, new hardware may be detected automatically during
the system restart. If Windows 95 detects new hardware, a New Hardware Found
window appears, and you are prompted for information about the device so that
Windows 95 can identify and load the appropriate drivers. You must then restart the
system for the configuration information to take effect.

If you are using Windows NT, each device driver must be loaded manually. Refer to
the documentation that came with the device for driver installation instructions.

Backing Up Files

It is important to make backups (copies) of all your data files. Data files are the files
(documents, graphics, records, and so on) you create with your programs.

NOTE: No backups need be made for software packages or for your operating system.
You made your Dell-installed software backups when you created program diskettes
in Chapter 1, and an operating system CD and boot diskette came with your system.
Additionally, any software you purchase comes with diskettes or CDs.

CAUTION: If you have not already done so, it is extremely important that
you create program diskette sets of your Dell-installed software. For
instructions, refer to “Making Program Diskette Sets” in Chapter 1.

Refer to the ’Maintaining the System* section of the Online Guide or “Preserving
Data” in Chapter 1 of the Reference and Troubleshooting Guide for more information
on backing up data files.

Dell Dimension XPS Dxxx Systems Setup Guide



CHAPTER 5
Using Computer Hardware

This chapter provides information and tips on using your computer hardware (physical
parts of a computer system). It also includes general instructions for adding a printer.

Many of the computer devices you might want to use or connect come with their
own instructions and/or software. You should follow the device manufacturer’s
instructions when connecting and using these devices.

WARNING: For your personal safety and protection of your system, always
turn off your computer system and disconnect it from AC power before
attaching any devices.

Video Display

The video display system consists of the video card installed in the computer and the
monitor connected to it. They work together to produce the picture you see on your
screen. To display a program at a specific resolution (maximum number of pixels that
can be displayed), both the video card and monitor must support it and the necessary
video drivers must be installed.

Changing the Display Resolution in Windows 95

Refer to the static sticker shipped on your monitor or the monitor documentation for
the recommended resolution. To set the display resolution, follow these steps:

1. Click the Start button, point to Settings, and then click Control Panel.

2. Double-click the Display icon, and then click the Settings tab (see Fig-
ure 5-1).
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Figure 5-1. Windows 95 Display Properties Window

3. Point the mouse cursor at the slidebar in the Desktop area. Then click
and hold down the left mouse button.

4., Move the slidebar to the left to decrease the resolution or to the right
to increase the resolution.

% NOTE: As the resolution increases, icons and text appear smaller on the screen.
5. Click Apply.

A dialog box informs you that the process may take 15 seconds and that the
screen may flicker while the resolution is changed.

6. Click OK and then Yes to accept the new setting.

For more information on monitor adjustments, refer to the documentation that came
with your monitor.

Changing the Refresh Rate in Windows 95

The refresh rate is the rate at which the monitor redraws the video image on the mon-
itor screen. The higher the refresh rate, the less video flicker can be seen by the
human eye. If the video image appears to flicker (typically at a refresh rate of 60 hertz
[Hz]), select a higher supported refresh rate by following these steps:

1. Click the Start button, point to Settings, and then click Control Panel.
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2. Double-click the Display icon, and then click the Settings tab.

3. Click the Advanced Properties button.

4. Locate the Refresh Rate section and click the pull-down menu (see Fig-

ure 5-2).
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Figure 5-2. Windows 95 Advanced Display Properties Window

5. Click the desired refresh rate.

Adapter Default sets the monitor to 60 Hz. Optimal sets the monitor to the high-

est refresh rate possible according to the resolution selected. This setting is

controlled by the horizontal (scan line) frequency range of the monitor.

6. Click Apply.

7. Read the instructions that appear in the dialog box, and then click OK

to continue.

8. Read the new instructions that appear, and click Yes to accept the new

setting.

For more information on monitor adjustments, refer to the documentation that came

with your monitor.
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Changing the Display Resolution in Windows NT

Refer to the static sticker shipped on your monitor or the monitor documentation for
the recommended resolution. To set the display resolution, follow these steps:

1. Click the Start button, point to Settings, and then click Control Panel.

2. Double-click the Display icon, and then click the Settings tab (see Fig-
ure 5-3).
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Figure 5-3. Windows NT Display Properties Window

3. Point the mouse cursor at the slidebar in the Desktop Area. Then click
and hold down the left mouse button.

4., Move the slidebar to the left to decrease the resolution or to the right
to increase the resolution.

@ NOTE: As the resolution increases, icons and text appear smaller on the screen.
5. Click the Test button.
6. Read the instructions and then click OK.

7. If you see a test bitmap pattern, click Yes and go to step 9. Otherwise,
click No and go to step 8.

8. Read the message, and click OK. Select a different display resolution,
and then repeat steps 3 through 7.
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9. Click the Apply button to change the settings.

10. Click Cancel or OK to exit the Display Properties window.

Changing the Refresh Frequency in Windows NT

The higher the refresh frequency, the less video flicker can be seen by the human
eye. If the video image appears to flicker (typically at a refresh rate of 60 Hz), select a
higher supported refresh frequency by following these steps:

1. Double-click the My Computer icon, and then double-click the Control
Panel icon.

2. Double-click the Display icon, and then click the Settings tab (see Fig-
ure 5-3).

Click the pull-down menu in the Refresh Frequency area.
Click the desired refresh frequency.
Click the Test button.

Read the instructions, and then click OK.

N o v » o

If you see a test bitmap pattern, click Yes and proceed to step 9. Other-
wise, click No and go to step 8.

8. Read the message, and click OK. Select a different refresh frequency,
and then repeat steps 3 through 7.

9. Click the Apply button to change the refresh frequency.

10. Click Cancel or OK to exit the Display Properties window.

Keyboard

The keyboard that came with your Dell computer probably looks similar to the one
shown in Figure 5-4.

One of the special keys on your keyboard is the Windows logo key. When pressed, it
displays the Start menu. The Windows logo key may also be pressed simultaneously
with other keys to perform the functions listed in Table 5-1.
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Windows
logo key

function
keys
<Esc> <Enter>
key\ key
I R 174 O A | numeric
N /248 I keypad
I AT 2
N 4 I
[ A [
LI ] I O
Figure 5-4. Typical Keyboard
Table 5-1. Windows Logo Key Combinations
Function Key Combination
Minimizes all open windows e Ga——
= M
Maximizes all windows (. D'
5 Shift I M ]
Opens Windows Explorer (?‘ )
= E
Opens the Run dialog box G "aa—
=h R
Opens the Find Files dialog box f_\”‘fﬁ f—*F
Opens the Find Computer dialog box (if (. Y
you are connected to a network) =A Ctrl I F
Opens the System Properties dialog box )
::33 Pause
\ N Break
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To adjust keyboard operation, such as the character repeat rate, double-click the Key-
board icon in the Control Panel (refer to “Control Panel” in Chapter 3).

Mouse

The mouse that came with your Dell computer probably looks similar to the one
shown in Figure 5-5.

wheel

left button \

/ right button
\ )

Figure 5-5. Microsoft IntelliMouse

The mouse’s left button is typically used to select options from menus, activate but-
tons, and highlight text in various programs. The right button frequently activates
menus with shortcuts for performing various tasks. If you have a Microsoft
IntelliMouse (see Figure 5-5), it includes a wheel that you can rotate forward and back
or press like a button to perform a number of operations.

The following software is required for using the IntelliMouse wheel:

®  Windows 95 or Windows NT Workstation
®* IntelliPoint 2.0

® Applications that support the wheel; for example, Microsoft Office 97 or
Internet Explorer

The applications being used determine how the wheel works. If you do not have all
the necessary software, the IntelliMouse functions as a standard two-button mouse.

To adjust mouse operation, such as the pointer speed and right/left-handed button
configuration, double-click the Mouse icon in the Control Panel (refer to “Control
Panel” in Chapter 3). For more information, refer to the mouse documentation that
came with your system.

Using Computer Hardware  5-7



5-8

CD-ROM and DVD-ROM Drives

Your Dell computer came with either a CD-ROM or DVD-ROM drive. Both drives read
audio CDs and a variety of other CD formats. The DVD-ROM drive also plays digital
versatile discs (DVDs).

To use a disc in the drive, follow these steps:

1. Press the open/close button on the front of the drive to open the disc
tray.

CAUTION: Do not press down on the disc tray when opening or closing it.

2. Place the disc in the center of the disc tray with the label side facing up
(see Figure 5-6).

N
A

Figure 5-6. Properly Inserting a Disc

3. Close the tray by pressing the open/close button or by lightly pressing
the front edge of the tray (the tray will automatically close).

NOTE: High-speed CD-ROM drives spin the CD at a very high rotational speed
and may be noisy. If a CD has printing on only half of the disk, or if there is a
slight imbalance in the CD, the imbalance is greatly magnified by the high speed
and the noise is louder. This effect is inherent in the high-speed technology and
does not indicate a problem with the drive.

When using a CD-ROM or DVD-ROM drive, follow these guidelines:

® Never use damaged, broken, or deformed discs.
® Do not press the open/close button while the computer is accessing a disc.
¢ Keep the disc tray closed when not using the drive.

For more information on using your drive, refer to the drive documentation that came
with your system.
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Speakers

If you ordered speakers with your system, connect them as illustrated on the Getting
Started sheet that came with your system. Also refer to the documentation that came
with the speakers.

Subwoofer frequencies are nondirectional. Therefore the subwoofer does not need to
be placed in a particular relationship to the satellite speakers. Dell recommends that
you place the subwoofer on the floor under a desk.

NOTE: Avoid placing speakers or a subwoofer near the monitor. The magnetic field
they generate may degrade the picture.

To adjust the volume of the speakers, use the volume knob on the front of the
speaker. To adjust the volume of the signal being produced by the computer, click the
yellow speaker icon at the bottom right of your screen. A small window appears with
a slidebar. Click and hold the slidebar; then move it up to increase the volume or down
to decrease the volume.

When you adjust the volume knob on some Universal Serial Bus (USB) speakers, a
window pops up on your screen that provides various audio controls. For information
on using this interface, refer to the documentation that came with the speakers.

Microphone

If your system came with a microphone, connect it as illustrated on the Getting
Started sheet that came with your system. Experiment with microphone placement
to achieve optimal recording levels.

Adding a Printer

CAUTION: To maintain a strong signal from the computer, use a
bidirectional parallel cable measuring 10 feet or less. Longer cables may
prevent the printer from operating properly.

Most printers come with specific instructions for connection and installation of neces-
sary software and drivers. If your printer does not, follow these steps:

1. Turn off the computer and any attached devices. Then disconnect them
from their AC power sources.

2. Connect the printer cables as instructed in the printer documentation.

3. Reconnect the computer system to AC power. Turn on the printer, and
then turn on the computer system.

4, If the printer is not automatically detected during operating system
start-up, double-click the My Computer icon on your desktop.
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5. Double-click the Printers folder.
6. Double-click the Add Printer icon.

7. In the Printer Wizard dialog box, click either the My Computer option
or the Network Printer Server option and then click Next>.

8. Click the port that you want to use.

Choose the computer port to which you connected the printer. The parallel port
with the printer icon is LPT1, and is the most commonly used printer port. The
serial port, marked with “1/O,” is the COM port. Refer to the printer documenta-
tion to determine which port to use.

Verify that the port you chose is not already assigned to another device. If neces-
sary, add a port or configure a port by using the buttons in the Printer Wizard
dialog box.

9. Select the printer manufacturer and model from the list provided, or
click Have Disk... if your printer is not listed and the printer drivers are
on a diskette.

Refer to the documentation that came with your printer for more information.

10. Provide the printer name (up to 31 characters) and click Next>.

11. Indicate whether the printer will be shared with other network users by

clicking either the Shared or Not shared option.

.

If the printer will be shared, the Connect to Printer dialog box appears. Continue
to step 12.

If the printer will not be shared, go to step 14.

12. Select your printer from the list provided or type the printer name, and
then click OK.

13

Select all the operating systems (from the list provided) required to
print to the shared printer.

14. Click Next> to continue.

15. Select Yes or No to indicate whether you want to print a test page. Then
click Finish.

System Upgrades

You can purchase various upgrades for your computer, including memory, hard-disk
drives, printers, scanners, and so on. Refer to “Available Upgrades” in Chapter 1 of
the Reference and Troubleshooting Guide for information on upgrading your system.

5-10 Dell Dimension XPS Dxxx Systems Setup Guide



~Z

CHAPTER 6
Frequently Asked Questions

Many common questions about your Dell computer are answered in this chapter. If
you do not find a solution, refer to the “Contacting Dell”” section of the Online Guide.
For troubleshooting tips and diagnostic tools, refer to the Reference and Trouble-
shooting Guide.

General Questions

How do I access the Online Guide for information about
my system?

To open the guide, click the Start button, point to Programs—>Dell Accessories, and
then click Online Guide.

Where can I find the specifications for my system? For my
installed devices?

System specifications are provided in the “Specifications” section of the Online
Guide and in Appendix A, “Technical Specifications” of the Reference and Trouble-
shooting Guide. Specifications for installed devices can be found in the device
manufacturer’s documentation that came with your system.

How do I connect to the Internet?

Instructions for accessing the Internet can be found in Chapter 2, “Connecting to the
Internet.”

Software Questions

I've lost the Dell Channel. How do I get it back?

The Dell Channel can be downloaded from the Dell Channel subscription page at
http://www.dell.com/getie4.
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Is there a new BIOS available for my system? Should |
update?

Basic input/output system (BIOS) updates are available from Dell’s File Library; they
are released to either fix problems or add features. You should probably not upgrade
your BIOS unless it is recommended by a Dell technician or you are experiencing
problems with your hardware configuration. Always read the release notes included
with the update thoroughly before making a decision to upgrade your BIOS.

Why am I having problems installing MSN on my system
running Microsoft Windows NT?

The Microsoft Network (MSN) will not install on the Microsoft Windows NT operating
system.

Will my system correctly handle the Year 2000 problem?

Your computer is set to automatically correct the date after 1/1/2000 occurs. It will
then continue to keep and update dates correctly. For more information about Year
2000 issues, refer to the Research and Development section of the Dell Web site
(http://www.dell.com).

Hardware Questions

The formatted capacity of my hard-disk drive seems to
be smaller than what I ordered. Where is the missing
space?

The operating system reports drive capacity assuming that 1 megabyte (MB) equals
1,048,576 bytes. This calculation is technically correct.

Drive manufacturers compute the size differently. They consider 1 MB to equal
1,000,000 bytes. This difference can cause confusion! If the drive is advertised as
4.3 gigabytes (GB) (4,300,000,000 bytes), the operating system sees it as approxi-
mately 4.1 GB (4,300,000,000 / 1,048,576 / 1000 = 4.100799560547).

Why do I have a line (or two lines) across my monitor?

Trinitron monitors use aperture grill technology, which is analogous to a vertical grat-
ing. A horizontal wire (one for smaller monitors, two for larger monitors) is strung
across the aperture grill to prevent image distortion.

The line that you are seeing is the shadow cast by the horizontal wire(s). Although the
shadow can be distracting, it is usually not very noticeable, and Trinitron monitors are
noted for their exceptional brightness and image sharpness.
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My monitor flickers or shakes all the time. What can | do?

Many things can cause the monitor to flicker; they are all simple to fix and do not
require hardware replacement.

First, turn the monitor off and then back on. You may also press the degauss button if
your monitor has one (refer to the documentation that came with your monitor) to get
rid of any magnetic field that may have developed during normal monitor operation.

Next, try moving the monitor to the other end of the desk to get rid of the flicker. Also
try separating the monitor from sources of electrical interference (such as speakers,

power cables, fluorescent lights, or something in the wall or on the other side of the
wall).

Finally, increase the refresh frequency if both the monitor and video card support a
higher rate at the chosen resolution. For instructions, refer to “Changing the Refresh
Rate in Windows 95 or “Changing the Refresh Frequency in Windows NT” in
Chapter 5.

My monitor is flashing different colors when I change
screens. How do | fix it?

If your monitor is flashing different colors when you change screens, follow these
steps:

1. Click the Start button, point to Settings, and then click Control Panel.

2. In the Control Panel, double-click the Display icon. Then click the
Settings tab.

3. Change the Color palette to High Color (16 bit) or True Color (32 bit).
Then click OK.

4, In the Compatibility Warning window, click the Apply the settings
without restarting? radio button, and then click OK.

5. When prompted, click OK to adjust the display.

6. When prompted, click Yes to accept the changes.

Where can I find drivers for my monitor?

Monitors do not require drivers; video cards require drivers. If the question is which
monitor to select, choose either the Dell monitor model you have or the Plug and Play
monitor (VESA® DDC option). If the question is which video drivers to use, use the
ones provided with the video card. Newer drivers may also be available from the Dell
Web site (http://www.dell.com).
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Posted on the Dell Web site and the Dell bulletin board service (BBS) is the
dd78906.exe file. This file self-extracts into dellmon.inf and contains information on
the latest Dell monitors. To use this file, follow these steps:

1.

. .

[ I N O

Download the file onto a diskette, and insert the diskette into the dis-
kette drive after the operating system starts.

Click the Start button, point to Settings, and then click Control Panel.
Double-click the Display icon, and then click the Settings tab.
Click the Advanced Properties button, and then click Monitor.

Click Change and then click Have Disk. Specify the location of the
dellmon.inf file (A:).

Getting Help

Dell provides a number of tools to help you if you don't understand a procedure
described in this guide or if your system does not perform as expected. For informa-
tion on these help tools, see Chapter 8, “Getting Help,” in the Reference and
Troubleshooting Guide or the “Contacting Dell”” section of the Online Guide.

If you need help with hardware or software that was not Dell-installed, contact the
manufacturer of that item. For DellWare items, call 1-800-753-7201 to receive product
support information.
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